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BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 9-
B Morph Tool Advanced 
 

Welcome everyone to the ArchiCAD Best Practices training lesson on the Morph Tool Advanced. Earlier 

this week, we had the basics of the Morph tool. I hope you had a chance to watch that. We'll do a very 

quick review of a couple of the basics and then launch into some more advanced applications of the 

Morph tool. I am in ArchiCAD here, and we are in ArchiCAD 16 or later. We have the Morph tool 

available. The Morph tool has several different ways of drawing elements, from just simple lines or poly 

lines to a box or other forms and shapes that are 2D. [0:00:47] 

This is a rectangle, and this is a box here. It has a certain height, whatever you choose. Then you can do 

a rotated form. You can click to say where you want it to be rotated around, whether a full circle or 

180˚. Now if I go to 3D, those elements that I just drew showed up in 3D. So even though there is a line, 

and this looked like a rectangle, they are 3D here. I will undo back all of those elements, and let's look at 

some things that are trickier that I have been experimenting with. [0:01:25]  

And frankly, I have to say that I am not an expert on the Morph tool. I am learning as I go as people ask 

me, "How can you apply it to certain things? Could you do that?" So one thing that came up, if I go back 

to 3D, is the idea of an organic form, like a couch. Graphisoft has some cool animations for creating 

furniture, and how would you create that? Well, I experimented a little bit. I got something starting to 

look like a couch. Let me demonstrate how this works. [0:01:58] 

I am going to pick up the settings of this morph here. Let's say that I am drawing this as a rectangle, so I 

am doing the shape that I had. Let's say 6x2. If I go to 3D, we are going to see that I eyedropped it. So 

this particular morph is made out of a particular material here as an override for the surface; a particular 

paint color. It wouldn't be made of paint, but we can use any surface appearance that we want. I can go 

to the top surface and say that I want to extrude it up. I don't want a tube or make it follow a path; I just 

want to extrude it up. [0:02:45] 

Let's say that I want it to be 1' high. So that's a platform there. Now when I do the next piece, I might 

want to put this on top of it. And if we do this here in 3D with nothing selected, I have this set up with 

the Morph tool like a rectangle. I can literally snap to this and it's going to create something here. This 

has a snap, because it has the usual snaps at the halfway point there. What I just did was drew a new 

element. I can select it and highlight it. I drew it right on top, so it knew that its height was at the 1'. One 

of the nice things about the Morph tool is as you are drawing it in 3D, you can snap to elements. 

[0:03:39] 

Now suppose I wanted to make this a hair smaller, so the cushion wouldn't go right out to the edge. 

Remember I can go to a corner, and there is an option like we have with polygons, to inset this. I will 
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take this and say I wanted it to be a half inch in, just a small amount. If we zoom in, we can see that it's 

slightly indented from that. I will select this and loft it up 6" here. So now I have a cushion. It's very 

square, like Styrofoam or something like that. Here is one of the things that you can do to make it more 

interesting. I will show you one thing I tried that is useful, but wouldn't necessarily give me the best 

result for an organic form. [0:04:38] 

Certainly, it's important to know about. If I select the entire morph with the arrow tool, I can pull and 

push the edges and surfaces. Let me select this here, and I will go to the top edge. You can see this 

option to inset it. You will notice that it is offsetting this front face. I was on a corner that was 

ambiguous. If I wanted to go and inset this to make it smaller at the top, I could use its face and use that 

same option. It's now finding the boundaries of that particular face. So you don't have to be at the edge, 

you can be in the middle of it. [0:05:35] 

Much like the magic wand, if you have a clean boundary, it will find the outer edges of it. Now if I click or 

type in a value and hit enter, it will make this have the shape that we see. But if I press and release the 

Option key on the Mac or the Ctrl key on Windows, you can see the tiny plus sign showed up next to the 

pencil. And now you can see it's actually creating a new edge, not moving the existing one. So let's take 

this in 3", just a small distance. Now there is a new edge there. And that has subdivided that surface. If I 

go to this outside and pull it, it's going to create this. I'll rotate it around so we can see it. [0:06:28] 

I can take this up or possibly down here. That's not what I want for a couch. Maybe I will take this one 

up here. That actually wouldn't work very well either. What I might want to do is select this edge and 

pull it up with the face. So remember that we can select individual parts of the morph by going to the 

arrow tool and switching the sub element selection here. That way, when I click here, it's going to select 

just that edge. And I can Shift+click these four pieces here. I will go and say that I would like to move 

them up or down like this. Right now this is moving it horizontally in space. [0:07:32] 

That is because of the current editing plane. I can switch the editing plane under the View menu, Editing 

Plane, Vertical. So now it's vertical, and with the movement that I am doing, the editing plane is now 

vertical. I will take this up on an angle. I am not an expert in terms of controlling this. In fact, I actually 

moved it up but not straight. I think I had to rotate a bit there. But what I was experimenting with was 

trying to make this a curved top. While we can do this and get this to bump up a little bit, I found there 

was a better way to get the organic edge effect. I will put this back to the normal selection here. 

[0:08:39] 

If I select the morph as a whole and go to this edge here, there is an option that asks if you want to fill it 

or chamfer the edge. So you have to have two adjacent surfaces, and you need to then choose a radius. 

It will then propose something. Let's just make this 2". I will tell it a certain size that I want it to affect, 

and it can do one edge or multiple edges. You can see what it did here was rolled this edge. Now I can 

make edges soft so that we don't see them. The other way to get that sub element selection, to change 
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the arrow tool here, is to hold down Shift+Ctrl. This changes the arrow from the normal black one to the 

sub element selection. Then I can pick these two edges here and go into the morph settings and make 

them soft. [0:09:48] 

By doing that, you can see how it now as a nice, rolled edge. That's a very simple way to roll one edge to 

get a bull nose. I can do it to the other side as well. If I wanted to do all four of those edges at the top at 

the same time, then I might want to select the four edges here. I am using the Shift+Ctrl and holding it 

down while clicking on a series of elements. With the four edges selected, go to any one of them and do 

that same option and apply to all edges. This will apply to all edges that are selected, and you can see 

how it's made that a more rounded shape. [0:10:34] 

Obviously I want to make this soft in this particular scenario. So I am going to go in and select these 

edges. It's a little bit tedious, and I don't know if there is a shorter way to do it. But I will go and select all 

of these edges around and get a good angle on it. I will make sure I am selecting the right one and 

getting a good angle. So now I have a bunch of edges selected here. Right now it says there is one morph 

but there are eight edges. In the info box, you can see a bit of information about that. Here is where you 

can do this on the fly in the info box, by the edge type there. [0:11:27] 

That worked, and now it's much softer looking. Now I still have a line on the corners. In some views, it 

may be more common than others that you can see. Maybe that's not bad, because it does indicate a 

change of plane. But if we wanted to, we could select this edge here and make it soft. Now you can see 

what that does. I can go to each of these outer edges here and make them soft. Now it will not show 

that edge. You can see how this one has a hard edge and this one does not. So depending on what you 

want. I will undo that back so you can see the difference. [0:12:15] 

That is one type of organic modeling that we can do. If I select this as a whole, if I select the morph with 

a normal selection tool and go to the center, one of the options is a morph change. Now this is 

something that has a radius. I demonstrated this a little bit. You can see how, depending on whether I go 

up or down, it will create little indentations. So you could do things like the tufting. I am not exactly sure 

how I would use it. If I take this and make the radius bigger, we can start to get a little different, organic 

shaping in there. [0:13:47] 

Now I wasn't centered on that, so it's a little uneven there. Perhaps if I centered this more, this might 

give me a little more natural-looking form. As I do this, I am increasing the resolution or amount of detail 

on here. We have to be careful about that. In order to tell what it's doing inside, we have to go to the 

View menu, Onscreen View Options, and say 'Show Hidden Morph Geometry'. You can see what it's 

done; it has created this lattice work of points that created that bulge. There is a little triangle between 

each one. [0:14:38] 
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Once we have the hidden morph geometry selected, I can then select the individual lines here which are 

set to be hidden, which is why they are normally not shown. Or I can select individual planes. We can do 

things like select a few of these planes here and perhaps change them to a different color, just to 

demonstrate what's going on. [0:15:08] 

If I want to select the entire surface to affect it, then I need to turn off the hidden morph geometry. 

Then when I select them, it selects the entire morph. You can see it's selected here. If I do Shift+Ctrl and 

click, I am going to be selecting just one face, which happens to be all of this. Be careful with showing 

hidden morph geometry, because it will only allow you to select individual pieces when normally you 

would want to select an entire face. Let me undo back. In this one here, if I select one face here, it's just 

this top edge. It's not selecting the side piece. [0:16:02] 

You can see how that's highlighted. If I have hidden morph geometry showing and I do the same thing, 

it's only selecting the top, the side, or one of these little pieces. You can see how this is rolled and there 

are some little pieces there. Hopefully that gives you some sense of the power in terms of organic forms. 

Let me show you how this is applied on another organic form here. Here is this big pot that I made. I will 

show you how that was done. I will go to the Morph tool here and do a lathed form. I will do it freeform. 

I could trace this ahead of time. [0:17:00] 

One thing is, I noticed this control palette is a little different than I'm used to. The three-point method, 

in most cases if I activate that, would do a second and then a third point. But now, you will notice that 

the second point is the end of the arc and the third point does not extend it. So what I want to do is 

backspace to this. I am going to say I want to go to the end, take this straight up, and curve it out. This is 

a convenient way to do this. If I want to take this straight up, and then out, I can get that shape. So be 

aware that this three-point one has a slightly different way of working. [0:17:45] 

I will put it back to straight and finish on this point here. Now I have it set for revolved shape. Remember 

it's the bottom tip that is sensitive, not the center body. I have to have the little tiny bottom crosshair on 

something for it to be sensitive, and then I can take this up. You can see how it's mirroring it or revolving 

it around this axis line. I can choose whether it's going to be full revolution or partial. This will create a 

shape that is similar to what I had, except its painted blue here. As I rotate it around, you can see there 

is a hard edge here. If I wanted this to not be so prominent, I can select that one edge. [0:18:35] 

Now hidden morph geometry is turned on. So I am selecting just a little piece here. What I really want is 

for it to select that whole ring. So if I turn off the hidden morph geometry, then I can select the whole 

ring. So be aware that the hidden morph geometry should only be used selectively. If I take this and 

make it soft, then you can see how this blends in there. How would I rotate this up? I was experimenting 

with some of the methods of doing this. I realized that I could go and actually - you can see this is a snap 

point, because this is an arc through there. [0:19:26] 
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So I can select this. I have the morph selected. I can hover over here, get this point, and press down. You 

will notice that one of the items in the pet palette is that pencil. We've done this a little bit. The pencil 

allows me to create new pieces of the morph. [0:19:46] 

I can just draw this across here. I need to make it, instead of a revolved form, just a line. I can take this 

over here. What I did was I added another line. This is a lot like Sketch Up, where you can literally just 

put a line on top of a surface. Having done that, if I select morph, I can rotate this around this edge. 

Interesting…I know I've gotten sensitivity to this before, where it's immediately given me the 

perpendicular. Let me see if I - ah, okay. So I pressed and held down while went from one point to the 

other. [0:20:52] 

Now you can see the rotation is set on this angle. I can go in and go from the one axis to the other. You 

can see the snaps. Now this is hopefully exactly straight up. Let's go to the south elevation, and we 

should see. Yes, this did it. So while I am not getting everything perfect the first time, what I want to 

make sure you understand is that you can take something you create and draw on top of it to create 

guidelines that you can use for geometry. Just like you use drafting guidelines to help position things, 

you can do that with the Morph tool directly. [0:21:38] 

We could get rid of that line underneath if we need it. Now you can see how this particular morph has a 

rolled edge. How did I do that? Well, if I go back to 3D, we are going to see that this surface here, if I 

select the morph and go to this edge, there is an option here to roll it. Let's say OK. It says that the 

radius is too large, probably because of this curve coming into it. It automatically did the maximum that 

it allowed. You can see how it created that form. It's a pretty nice change. Let me undo it, because I 

want to find out one thing. [0:22:22] 

It actually kept the same top surface. If I wanted it to be hollow, I can hold down Shift+Ctrl to get the sub 

element selection. I can select just the one face and delete that. You can see now this is hollow. If I 

wanted to make this edge here soft, I can Shift+Ctrl to select that edge and then make it soft. Now you 

can see how it blends in. let me do the same thing with this one, make it soft. So I think you can see that 

there are a lot of possibilities for creating organic types of forms that you couldn't have done nearly as 

easily with ArchiCAD before this. [0:23:16] 

Practice will make perfect, and I don't claim to be in good practice. Let's proceed on to some other 

items. I have a question from Tom D., "Do morphs need to be drawn in plan? Can you rotate the object 

in an elevation view?" Yes. If I am in an elevation view, and I go to the Morph tool here, you will notice 

that the prompt does not show anything. If I click, it does allow me to draw a morph. So let me create a 

shape here. This is a series of lines. I will go to 3D, but I don't see those lines. Did it actually create 

something? [0:24:01] 
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Let me zoom out, and there is this element drawn way out in space. It's those lines that I drew. Why did 

it draw it here, when I was looking at these elements? The secret is that the elevation that I was looking 

at was this one. It drew that line here. This is the morph that I just drew. So if you wanted to draw it in 

elevation, in conjunction with this here, then I might want to create an elevation or section just for 

temporary purposes. I will open that section, and I will draw a three-point morph and then stop that. 

[0:25:12] 

It may not have snapped it quite precisely, but if I go to 3D, we are going to see that the morph piece 

that I just drew was on the section line. If I go back to the floor plan, there is a new element that I just 

drew. If I wanted it to be right on top of this morph or another one, I can move the section temporarily 

to be right there. Now I am looking at this area. If I right-click on this and open this section again, now 

we are seeing this morph edge in just dot form. That is an interesting option here. If I select it, there is 

an option for the morph for how it's going to appear. [0:26:09] 

I am looking at Floor Plan and Section - Cut Line. So that means that if it's cut, it's going to show 'Dotted 

Dense'.  Let's make this solid here and say OK. Now we can recognize it more. If I were to draw a shape 

now, and take that curve shape like that and go to 3D, we are going to see it's precisely in position there. 

So that is an important thing to know is that if you want to work in section or elevation, you can. If you 

create something new, it will use the plane of that section or elevation to define it. [0:27:00] 

Now in terms of rotating things, can you do it in that section or elevation? Absolutely. I am not sure 

what I would want to rotate here. But let's say if I wanted to take this morph and rotate it here, I can 

take it, rotate it, and take this up to any angle. This is actually just standing it up. While that may not be 

sensible for this particular element, drawing things in section or elevation can make a lot of sense, and 

then just rotating them around in another section or elevation as needed will be very useful. [0:27:44] 

I will undo that change there. So let's see. I have some other project files that I had used previously for 

demonstrating things about the morph. I created a video on my YouTube channel, and I can't remember 

if it's currently on the Best Practices Course website. But I talked about how to use the Morph tool to do 

treatments on an elevation. So I did a brief introduction to the Morph tool. We've already gone through 

how to create shapes and draw a line on top of it and create insets and indent them, things like that. 

Then I drew some stuff directly on the face of the building. [0:28:37] 

So I basically took a section of the floor plan here, and put a section right on the face of the building. By 

doing that, I was able to draw for example this morph here to create some façade detailing, and that 

element showed up in 3D directly. Now the other thing that I did in terms of the morph, in addition to 

drawing pieces of things that might be ornamental, is cut off the top. Sometimes with certain types of 

architecture, this could be a nice form. The wall here you can see is drawn up to some arbitrary height, 

and it's being cut by a morph element. [0:29:40] 
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That morph element is on a layer. I am not sure what layer I put it on, but let's select all and show here. 

You can see the morph here. You may be wondering why these morphs are showing with a solid, where 

some other ones are showing with simple linework. It's because these morphs are being cut through and 

they have a particular fill. This was done in ArchiCAD 16, so instead of having a building material (what 

the morph is made of), these were fills which is what you had in ArchiCAD 16 and earlier. Of course, 

when you cut through an element, you would see that particular fill. [0:30:34] 

If I look in 3D, having turned this on, I had drawn a volume. You can see the volume was the morph that 

I just extruded through at least far enough to cover the top of the wall. Then that wall I used a Solid 

Element Operations to trim it. Having selected it, I can go to the little popup that indicates what Solid 

Element Operations have been done. If I want, I can turn that off. Having done that, now this wall is full 

height. You can see it's going across the top here. Let me undo that. [0:31:18] 

You can see how the wall outline is trimmed neatly here. The use of the Morph tool for things like this 

can be very effective for basic geometry. Let's look at another application we have which is to modify 

elements that we import. I have another file open from a previous tutorial. So I imported this element, 

which was an IFC element. Let's take a look in 3D. This is the element that was directly imported from an 

IFC file. For those of you less familiar, an IFC is an exchange format for intelligent building models. 

[0:32:11] 

It's becoming more and more used to take architectural models over to engineering structural analysis 

as well as energy analysis or other treatment of the model. We can bring in elements such as these 

manufactured components directly into ArchiCAD if they are saved in an IFC format. IFC can be a way to 

communicate between ArchiCAD and Revit for example. We can also take in import elements from 

other forms. This is a DWG file that was imported into ArchiCAD. [0:32:56] 

Now this element here, as a DWG, we simply opened as a library part. I can show you that in a minute. 

You see how the symbol is really terrible looking with all those extra lines. Even in 3D, we can see all this 

extra faceting. Well, what I did here was I converted that into a morph. So how do you convert 

something into a morph? Let's repeat some of the process that we had in this tutorial. I will go to File 

menu, Libraries and Objects, and I will say Open Object. Open Object allows me to browse for a library 

part. [0:33:37] 

This library part can be a DWG file or it can be an IFC file. I don't know why it's listed in reverse 

alphabetical order, that's odd. But here are .ifc objects and things like that. I have some links here that 

had been sent by Tim Ball. Let me bring that up. He had sent information about importing objects from 

IFC from a BIM library that is available in the U.K. and also DWG. So if I go to this DWG page here, here is 

what that basin should look like, and it downloads as CAD drawings. It's taking a 3D DWG and saying I 

want to download that. [0:35:22] 
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I will save the file here. It downloaded there. In my 'Downloads' folder, you can see it's a .zip file, so let 

me click it to unzip it. Now here is the name, it's very descriptive. I guess that number is maybe a catalog 

number. I'll rename it, and we'll take out the extra .dwg there. So that's in my downloads. We'll go back 

to ArchiCAD, to the File menu, Libraries and Objects, Open Object. I can browse for that download. 

There it is. So I am not going to go into all the .dwg import options. Just say OK, and we'll bring it in. 

[0:36:22] 

It has some sub parts, general line-type shapes. We'll skip that. It says, "No elements were created." 

Okay. That's rather odd. Let's try that again. Go to Libaries and Objects, Open Objects, browse for the 

.dwg. I will go to the settings and make sure that it has 3D data going into the GDL script. "Convert 

Solids" - I'm saying I want to open this .dwg file and there are some settings here that may affect it. Let's 

see, we don't need to worry about pens, colors, or meshes. Convert 3D face. So there are different 

things that are actually making it more complicated. [0:37:59] 

Let me save settings. I have just made one change here, and let's see if it comes in okay. It's not 

converting, so that one change does seem to have done that. And here is the object. I said I wanted to 

bring in the 3D stuff. We'll save this as 'Duravit Basin' here. This is annoying. It says if I want to save it, I 

must choose a license on the details page. I don't know why it's asking me that. On the details page, go 

to License here. I will say it's public domain. These things, I'm not sure why, and don't want to go into 

explaining, but if you were going to sell it, you can say it was a commercial part. You are saying, "If I 

share this with someone else, they can use it, it's not mine." [0:39:20] 

Let me save this now. It's now saved, and I can go in and place this object. The reason I wanted to go 

through this demonstration again is that I wanted to point something out. If we look at this object by 

itself, we can't do very much with it, other than possibly make the whole thing a different color. So you 

could make it stainless reflective here for example. If we go into the settings for the object here, there is 

an option to use object surfaces. So I can change the material of the overall object, but I can't, for 

example, smooth out the facets or make the faucet different than other parts. [0:40:40] 

But if we turn this into a morph, which is an option here under the Design menu, Convert Select to 

Morphs, then even though the object still exists in the library, this particular collection of geometry will 

become a morph instead. It extremely complex, but we'll continue anyway. You can see how complex 

that is, and that is an issue sometimes. In this file, we just have a handful of them so it's not a problem, 

but if you did put in an apartment building and you wanted to have dozens of these, it could slow down 

ArchiCAD quite a bit. [0:41:18] 

Now in terms of the look here, instantly you have some difference. I will clean it up a bit by selecting it 

here. It's made up of several different pieces. I will select this one piece here, and let's see - this is 

another piece here. So one thing it's done is broken it up into pieces. I can make this piece here 

porcelain or something like that. Now the problem is we are seeing all those lines. I may want to select 
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this and change all the lines for this element to 'soft', that way it will only show the line if it happens to 

be right along the edge of the vision here. You see now it's quite a bit better. [0:42:32] 

Let's zoom out here. It's not perfect the way it's constructed, but we can go through these objects and 

select all of this stuff here and make it soft edges. Now it's much cleaner here. If I go to the floor plan, 

we can see the symbol for it is simpler than the original one, which was quite messy. I don't want to go 

back over too many things. But if you do import stuff, this can be a way to clean them up. You can 

actually select faces or parts of it and designate different materials or surfaces, which you could not do 

with a basic import from .dwg or .ifc. [0:43:34] 

Another thing that we can do is take any native ArchiCAD element and rework it using the Morph tool. 

One thing that I have heard mentioned is taking something like the Stair tool and adding more detail to 

it. So I will go to Stair tool and pop in a default stair here. I'll drag this over a bit. Let's go ahead and look 

in 3D. I see Bill E. started to write a note saying, "Eric," I'm not sure what you want to ask me Bill, but go 

ahead and keep typing. I will turn off the handrail on the stair to simplify what we are looking at. I'll go 

to 'Railings, Off'. [0:44:47] 

One of the things you may want to do is make a more ornate edge here. Let's take this and make the 

tread thicker. Instead of the tread covered thickness being 1", let's make it 2". It's going to be more 

prominent there. How would you do that? There's no option within the stair tool to make that a 

rounded edge. What we can do is select this. We could go and convert it to a morph. Right click on it, 

and say, 'Convert Selection to Morph'. Now, this element becomes editable. Notice the handles look 

different. [0:45:31] 

What could we do? Let's experiment. I will round it here, and you can see how that rounds that one 

edge. If I wanted to do it as a bull nose, this might be trickier, but I can see if I can do this. Remember, in 

the last lesson, I brought up the toolbar called 'Drafting Aids'. That's a very useful one when you are 

working with freeform style. I can say I want to set up the Editing Plane Display. I want to select an 

editing plane. Why is it not letting me select one here? It should be able to do that. Alright, maybe I have 

to start the editing operation. [0:46:36] 

Maybe I have to start the editing operation. If I want to curve this here, that actually is catching the 

correct one. It's in line just fine. Let's take this as 1" here so it will be a bullnose. Let's go to the other 

side and take that 1". Now you can see that sort of worked. We have an odd look here. As in the 

previous lesson, I am going to delete that face. I will Shift+Ctrl to get a partial element selection. I will 

select this one piece and delete it. You can see it's hollow. Then I will Shift+Ctrl to select this curved edge 

and that curved edge and use the option under the Morph to cover it with faces with a sharp edge. 

[0:47:39] 
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Now it's going to create a nice, smooth thing there. This point here, do we want to see this line? Maybe 

not. I will Shift+Ctrl+click on it, and at first I thought you could delete it, but look what happens. It 

actually gets rid of both surfaces, because there is nothing to connect them. So rather than deleting it, I 

will just make it soft. Now you can see we end up with a nice result. So it would be tedious to go through 

every step, but at least it's possible to do that. [0:48:21] 

So Mariah says, "Because you have an object selected." So you say, "Select an editing plane would be 

available if I didn't have something selected?" No, it's not available there. I am not sure why that's not 

available at the moment here. Bill E. says, "Eric, as I asked the other day, can you add other non-morph 

elements, such as rafters, to a morph shape or roof or vice versa? Add a morph form to a roof to make a 

morphed roof?" Well, I guess the quick answer is that you can convert any element to a morph if you 

wanted to take a standard roof and turn it into a morph. [0:49:14] 

It would become an editable thing, like I have just made this stair. If we think about this stair here, the 

geometry is now more flexible. I can pull, push, or change the individual materials of the treads. There is 

just more flexibility there. On the floor plan, what we are seeing is a top-down view of the stair. It's no 

longer a symbol like we had before. If I go back to the Stair tool and place that, obviously this has a 

walking line, tread line solid, and the body of the stair underneath dashed. We have a break line and 

things like that. And this does not have that. [0:50:00] 

One possibility would be to have the stair object that you would explode. This would be interesting - let 

me go to 3D and try to rotate this around. So the stair here, I will select it and take off those railings 

again and get it similar to what I had. Now I will go explode it by going to Edit, Reshape, Explode into 

Current View; and select 'Keep original elements too'. What did that do? If I select this and drag it over, I 

now have three things: the original stair that was turned into a morph, this stair, and this set of lines. So 

these are individual lines. I exploded this. [0:51:23] 

So if I had left this in its original position, then what I could do is convert this to a morph and in the same 

place have the original symbol there. Then I could turn on or off different layers. In 3D I could have a 

more complex version that was a morph, whereas on the plan I would show the stair symbol or just the 

linework for the stair, your choice. Then of course you can edit this as desired. So it's not a fully 

integrated model that way, but it does give you more flexibility to have a symbol the way you want it. 

[0:52:02]  

This was a little side diversion from Bill E.'s question about the roof. So let's take the roof and do just a 

simple roof here and go to 3D. I will select this edge here just for fun. If I convert this element here into 

a morph, it looks the same still. On plan, we just have a top down view of that element. Then, having 

made it into a morph, I could do some more editing of the shape. I could add rafters and things like that. 

But adding rafters, I don't know why you would want to turn it into a morph or why you were thinking 

the morph would be helpful. [0:53:13] 
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The morph tool primarily is used for creating geometry that otherwise would be hard to do in ArchiCAD. 

So if you can do it with the built-in tools, then do it that way. For example, if the stair doesn't have a 

certain option, then this is a legitimate possibility for you to take a starting point with what it creates 

and modify it. Let's see, so Ron H. asks, "If the nose if 2", why don't you just select the top and bottom 

edges, setting the round to 7/8" and getting the same effect of the bullnose? This way, you can select all 

the nosings at once." [0:54:01] 

Okay, so let's see how that would work. So you are thinking, why am I not selecting just this top and 

bottom edge here, go to the rounding. It's putting something in here. Let's just say 1". Actually, I didn't 

tell it to do it on all edges at once here. Apply to all edges. It says it's too large there. So it did curve that 

around. Now this particular edge, can I make this soft? Select that one, make it soft there. Okay, that's 

pretty darn close. If I were to select - it's saying it's one surface there. It's pretty much the same as the 

other one. So that could be a way to do it, depending on how you work it. [0:55:18] 

So you were saying, could we do this on multiple ones at once. If I select one, two, three, four. Whoops, 

I got the wrong one there. You have to make sure you are picking the right one. Getting the right angle 

on it will help. I now have several faces selected and go to any one of them and fill, apply to all edges. 

And well, it did these two and not these other ones. So I am not sure why that is. Let's try it here, apply 

to all edges. It's only doing related ones here, then I would have to clean up the soft edge. So I'm not 

sure, you can experiment with these tools and see what gives you the best result. But it was a nice idea. 

[0:56:26] 

There may be some other options in the Morph tool that will work. I haven't explored all the options 

here. So Mariah asks, "Do you just put the lines over the morph and hide the morph?" In terms of that 

symbol for the stair, yes, if you wanted to have the morph version of the stair that you reworked in 3D, 

but have the symbol from the stair on the plan, you could have the stair object. Let's say it was perfect. 

The stair object is just the way you want it. You could have the stair object layer turned on in 2D and the 

morph turned off. Then when you take a 3D view in section or elevation, you would turn on the layer 

with the morph and turn off the layer with the stair, so you would only have one version of it. [0:57:19] 

Scott N. asked, "Can you briefly explain the 'union' feature of the morph tool? Okay, let's see. This is 

something I have done a little bit in practice, but haven't done for a while. How does the union feature 

affect things? We should explore something about solidity and the union part would be part of it. Also 

resolution, because that was something I know has come up in terms of the shape. I will take a large 

circle to demonstrate resolution here. Go to the Morph tool and say I want to create a circular version 

here. [0:58:23] 

I will click twice. This is now in 3D, and we can see a circular piece. If I extrude it up here, it's a water 

tower or something like that. Then I had it in the tubular extrusion so it's going to extend like a pipe. This 

looks pretty good, but if I zoom in on it, you will see that it's actually faceted. So this may be an issue 
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with the fact that it's a series of straight lines every 10˚. You do have some options here. If I select this, 

there is an option under the Design menu, Modify Morphs, Modify Segmentation. When I do that, it 

allows me more segments. I am not sure the difference between having 'double' on or off. I will say OK. 

[0:59:23] 

You can see a subtle change here. I will zoom in on this. If I undo, you can see the straight edge, and 

when I redo you can see how it's doubled the number of segments. So depending on the angle, and 

what size element, that may be effective. Now in a full circle, it probably doesn't show up too much 

anyway. It's where you might have a very gentle curve that it might be more of an issue. So I will draw 

something like this here. Let's take a look at that in 3D. You aren't seeing it too much. I am trying to 

remember where people have come up with this issue. [1:00:25] 

This is just a small segment, so it only has a few pieces. I am trying to remember where it would be. It's 

not coming to me when this becomes a prominent issue. But just be aware that you can modify the 

segmentation there. Now in terms of the union, let's just take these two elements here. These are two 

morphs and I have them both selected. They are two elements. Go to Design menu, Modify Morph, 

Union. This will actually combine the two of them. Now when I select them, they are one combined 

element. [1:01:23] 

Now I can select it and drag it and they will both move together. But let me show you something that 

shows the power of union in a different way than being just a group. If you recall, I took a molding shape 

and extruded it around a square that was a top of a wall or top of an opening like for a fireplace. Well, if 

it had an arched top, then you couldn't do that nearly as easily. Let me show you what you can do when 

you work with this. I will go back, go to the other side, get rid of this stair. Let's say I wanted to have a 

window. We're going to pop in an arched-top window. [1:02:32] 

Suppose I wanted to have a type of trim that went around this here. I will draw a morph shape on this. 

Remember, I can go to the section or elevation tool and draw this along the space here and open it up. 

Now I am actually on the surface of the wall. So I will draw a new morph as a series of straight segments. 

This can be curved up. I'll take this across and curve, and do a straight segment down to here. This is a 

morph shape. If I go to 3D, we aren't going to see anything interesting, because the morph is actually 

right on the surface. I can select it and it has this green border. [1:03:50] 

Now what I want to do is go to the floor plan, and right next to this, I am going to create another morph 

shape. I will create something arbitrary, but more ornate. I am going to fillet that here and take this in. I 

want to make sure this is straight in line with that and take that down. So now if I go to 3D, there is the 

shape I created here that is lying on the plan. I am going to drag it up. I will say Command+D or Ctrl+D 

and snap it to that point. So now this morph is sitting up right next to the bottom of the window. I can 

select this morph here, and I can go and take this tubular shape and take it up and over another 

direction, but it's going to go straight. [1:05:05] 
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I guess we can curve it here, but we may not be able to automatically - or let's say, there's an option 

here where I can preset that curve. Let me explain that. If I select the other morph, I now have this 

green line here and this one here. I will unify them by going to the Design menu, Modify Morph, Union. 

Now they are a single morph. Now I can go to the corner here, take the tubular one, and now I can snap 

up to this point. I am going to hide everything else. This is a nice trick you may want to use when 

working on complex forms. [1:05:56] 

You can select one or more things, right click and say 'Show only what is selected in 3D'. So now we have 

something simple to work with. Take this and extrude that surface and take it up to that point. As I move 

it along here, it's following that curve. If I do a curve here and take it across to this point and up to 

where I snap to this here, and then take it as a straight segment and down to the end and stop it. Now if 

I go back and say, 'Show all in 3D', you can see that I have a pretty nicely done element here. [1:06:56] 

I think this may be where the straight segmentation thing is an issue. I will repeat this now that I have 

the mechanics of it and show how that straight segmentation thing would work. If I drag a copy of the 

window over here, and in this case we make the arch here and have a different shoulder height. This is 

5' and this is 4'6". Now you can see it's smaller- maybe even 4'8". How many segments is this tracing 

here? You can see that this is definitely segmented, and in terms of the morph, if we trace this around 

we would have a similar look and it might not look good for the trim to do that. [1:08:02] 

You would then select those elements and increase the segmentation. Rather than take the time to do 

that, you might say this would be the type of time when the segmentation would become an issue, 

because it's a shallow curve, and it really should be smooth, but it's saying it's going to show it every 10˚. 

We are noticing the segments. I don't know if the Union, if I really demonstrated a convincing case for it. 

There are times when you would want to take separate elements and group them together or unify 

them so that you can make them solid - that would be another thing. [1:08:46] 

So let's see, that would be a simple example, not necessarily a perfect one, but let me take this shape 

here, which is a form. If I look in the east elevation here and select that morph. I will draw another 

shape here. Now if I go to 3D, that shape is off in space here. Let me drag this over. This is a little 

awkward demonstration, but I have two separate morphs here. If I want to connect them, I can select 

the two here and unify them with the Union. Then I can go in and select this side and this side here with 

a Shift+Ctrl and say 'Cover with Faces'. [1:10:16] 

You can see what that's doing. That actually made that a solid form. So I am not showing the best 

examples; I wish I had some better ones. The idea is that you can draw these pieces in different views 

from different pieces and connect them together. You can create pieces and make them into one larger 

geometry. By unifying them, they have some options in terms of recognizing it. Now this element here, 

there is an option under the Design menu, Modify Morph that says, 'Check Solidity'. It says, 'All morphs 

in the current selection are solid.' [1:11:03] 
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What if I were to take this face and delete it? Now you can see it looks hollow. I will select it and do the 

same 'Check Solidity'. It says, 'The current selection contains one or more non-solid morphs.' Why does 

solidity mean anything? What does it do? You remember the operations which you probably have all 

done, and some of you do a lot, Solid Element Operations?  This type of trimming, cutting, unifying, only 

works with elements that ArchiCAD considers to be 'solid'. Essentially, bounded volumes that have a 

face, there's no airspace; air can't get in or out. [1:11:46] 

You can manually go and say you want to do this. And look this is interesting; I'm not sure if they had 

this in 16. It's highlighting the edges around a missing face. If I say 'Solidify', it will attempt to transform 

these into solids. Here it did work in this simple case. Sometimes you may have some complex forms 

that you have been working on and they may not be considered solid, so you may need to use that 

'Solidify' option there. Sometimes that may work perfectly, and sometimes you may find that it can't 

figure it out or it does it the wrong way. Then you have to manually add some surfaces to it. [1:12:34] 

Let's see if there are other questions. Steve N. writes, "Could you somehow save this molding as a 

favorite for use in one's window library?" Yes, you could. That molding that I created here, let's select 

and change the color. I will make it whitewash here. By the way, can we get rid of this line? If I select 

these lines that are showing and make them soft, that got rid of some of them. I will highlight the 

remaining ones. If I am going to save it as a part, I might want to get it all cleaned up. But I can actually 

do some pretty amazing things in terms of cleanup. [1:13:33] 

This would look beautiful in an elevation. We'll take that east elevation and you can see it's starting to 

look really good. Can I select these lines? In some cases, if they are visible right here in the elevation. 

You can see how that is working. There we go. I can zoom in. So it's sort of like you are deleting them, 

but really you are saying these surfaces shouldn't be separated. I will take this edge and make it soft. So 

that looks nice. [1:14:14] 

Alright, now if I select this, how would I turn it into an object? So this is a morph. It's not an object, but I 

can go to the File menu, Libraries and Objects, Save Selection As, Object. Instead of what I did earlier, 

which was to take an object and turn it into a morph and then do some manipulation, I am taking this 

and making it an object. So we could call this "Arch Top Molding". This would go into the embedded 

library or I could put it into a folder and load it into other projects. I could have it in this project now and 

later export all of the custom parts in this project into a folder so I can organize them and use them in 

multiple projects. [1:15:04] 

I will save here. There are some options in terms of the surfaces. This is beyond what I want to teach in 

this class in terms of saving objects, but basically, this will be somewhat parametric. If I go to the Object 

tool here, it does exist. And if I go to 3D you can see this element here is the object. Now if you wanted 

to have this with different heights or widths, you might want to save out different versions of it. With 

the Morph tool you can create multiple versions pretty quickly, but if we were to stretch this, it wouldn't 
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necessarily keep its shape. This reminds me of something that I think is important to know about. 

[1:15:59] 

If I wanted to take this morph and modify it - suppose if this window was taller. I am going to take this 

window and take the bottom all the way down to the floor here. This molding, if I wanted to edit it, I can 

zoom in underneath here, select the morph, go to that face. I have the little appearance; you can see 

how this indicates that I am on a surface. I go to the bottom surface and extrude it. It will extend it. It 

looks like it will be a line, but that's actually just a reference for where it started. [1:16:46] 

I can take this down and snap it, and you can see how that works. So I can take this face down here. So 

that would be the cleanest result. I can now save this as an object with a different size. Now if on the 

other hand I needed to make this wider, then it wouldn't necessarily work as well. This curve was 

created on the fly, and it's not going to be easy to change the curvature of all the elements there. 

Sometimes you can. I will show you an option for certain types of forms that could work well. Let me get 

a better angle on this. I will go to a corner here. [1:17:36] 

There is an option that is listed here called 'Box stretch'. This allows me to change the proportions of the 

box that this is in. it says, "Click on a face, edge or corner of the bounding box, stretch or skew." So let 

me click on this corner, and now you can see what it's doing. It's allowing me to make it narrower, taller, 

etc.  Let's make it wider, and you can see the proposed shape is just deforming. It says 'Click outside the 

box to complete'. So I can keep playing with it to get it right. If you look closely at it, you can see the 

proportions of these elements have changed. [1:18:40] 

It's probably a little hard to see that. Let's undo it and do it one more time and make it more extreme. I 

will say I want to do the box stretch, take this corner, and take it way over to there. I will click outside to 

finish. You can see I made the whole thing wider, and it made the cross-sectional profile wider here. If 

you did a subtle change, such as by a few percent, it would probably look fine. But if you did more, it 

would look pretty weird. But that box stretch is an important option. [1:19:28] 

We are at the hour and a half mark. I will see if there are some last questions here. What I would invite 

you to do is review this video after I have posted it, and if you have questions that come up afterward, 

send them into me. If I get a few questions that seem like they are important, I will schedule a third 

session on the Morph tool, or maybe just a ten minute or half-hour follow-up in our next lesson. Also if 

you have some specific things like, "I saw what you did but it made me think about this," and you send 

me a picture or something and say, "How would you do that?" I will take a look at it, and if it's 

something I can figure out how to demonstrate in the Morph tool I will be happy to do that for you. 

[1:20:25] 

There was a question from Mariah, "In the context of the stairs, is the Morph tool the one you use to say 

create a spiral ramp form for people to transcend levels in place of traditional stairs?" Okay, so that 
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might be something to consider. But specific to that particular question, if we go to the Object tool here 

and type in the word "ramp", you can see there is a curved ramp here. It's one of the standard library 

parts and it has various options for the radiuses, different sides off or on, side flange. If you turn off the 

flanges here, you can see this just a simple shape. Let me make the radiuses even smaller. You can see 

how, depending on what you are doing, it may look more or less segmented as it goes around. And the 

rise is 10'. If we make it 5', it's going to be shallower. [1:21:46] 

So basically, this would be what I would use as a starting point. If it was something that you wanted to 

customize afterward, you could turn this into a morph. This angle here is 270˚. If I make it 90˚, you can 

see what it's doing. It's creating a curve around 90˚ or 120˚. It will just rotate around whatever angle you 

want. So that would be what I would do for a ramp there. Certainly there is a way you could do a morph. 

You could create a profile and sweep it around, like how I swept this around the top of that here. If you 

created those curves in space, you could probably get it to work pretty well. [1:22:42] 

Hawei C. asked, "What is the difference between a morph and an object?" The morph is made with the 

Morph tool. Objects are placed with the Object tool. You can save things that you draw as an object. A 

morph or a combination of things that you put together can be saved as an object. A morph is 

something that you build out of components: lines, surfaces, boxes, revolved shapes. After you create 

them, you can combine them if you want into a larger collection. You can also convert elements into a 

morph. One of the things that are similar about them is that you can take any 3D thing in ArchiCAD and 

save it as a morph by saying 'Convert selection into morph'. You can go to the File menu, Libaries and 

Objects, Save Selection As, Object. You can covert things into morphs or objects. [1:23:54] 

If objects are programmed by someone experienced they are very flexible, but in general they are a 

simple representation of whatever they were when you saved them so they are not that editable. The 

Morph tool remains editable certainly in many ways as you can see from today's session. They have 

different purposes. Objects have a single definition and you place them in several times. Morph you 

would drag copies around if you wanted them, but they don't exist in a central repository. [1:24:37] 

Steve N. had a question about this arched top molding or casing. You could put a bunch of these into a 

file as reference ones, and then you could drag them around as morphs. You might have a bunch of 

windows of the same type and drag one of the standard ones in. You could have a file where you have 

these casings and have it open in another copy of ArchiCAD. For example, I could take this here, copy it - 

I guess I have to be on the floor plan to copy it. I will select this and copy it, then go to this other file 

here and paste. [1:25:24] 

You can see this now has come into this object. You could put these types of components in a file that 

you have saved for reference. So Mariah says, "Awesome, thank you." Steve N. said he's going to watch 

both sessions again, he got a good introduction to the basics. Mariah asked, "Is that in 16?" Pretty much 

everything I did today is in 16. The only difference that I can think of is when you describe an element of 
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any type, you are often picking a 'building material' in 17. Before 17, you had a 'surface material' and a 

'fill'. Now you have a building material that says it's made out of concrete or wood, and has a fill when 

you cut through it and a native or natural surface. That would be the only difference and wouldn't affect 

your geometry method. [1:26:37] 

Mariah says, "If I wanted that ramp u-shaped on the underside rather than flat, would that be a 

morph?" Yes, you could take that ramp object and convert it into a morph and then do some things. Use 

Solid Element Operations to cut out parts of it or you could create a custom profile that would create 

that shape. Marik S. asked, "To schedule a morph element, would you convert it to an object and 

schedule it or just schedule the morph as is?" You can't - I don't know what type of scheduling you want. 

There are no notes that you can add to it - with an object you can have notes and dimensions that this is 

a certain size window or cabinet. Those can be read off. [1:27:23] 

If you have a list of morphs, first of all it wouldn't show up under the schedules. If I go to the schedules 

here and open up any one of them and say that I want to create a new schedule here, element type is 

morph. Actually, let's remove this. Now what fields do we have for morphs? We can report on morph's 

areas or surfaces or volumes. Actually, this is one thing that is really cool that they added in 17, 'Area by 

Story'. I showed this in one of the coaching calls. Let's do this and put in an area and ID here. [1:28:26]  

This is one final teaser to show. So we have a bunch of morph pieces that are showing. Let me make this 

have the ID criteria. I only want to schedule - add here let's say the ID starts with "M" for morph. 

Interesting, one of them did start with that. But this is an example. I will go to the Morph tool and create 

a box, and let's make it 50 feet high. We go to 3D; this is now a shape here. If I go to that schedule, you 

can see that the morph has 'area by story'. This is a certain area and we want to put in the story here. 

[1:29:49] 

Where would story be? I'm not quite getting this here. Let's take a look in 3D. Let's say this were a 

complex form, select the morph, go to the edge and say I want to move it here. Let's imagine that we 

are doing a conceptual design for a building that was rather free-form geometry shapes. There is less 

area here than there is down here, and this is going up 50 feet, so 5 stories. Actually, there are only 2 

stories, that's why we only seeing it listed. Let's add several more stories. Say 'Insert'. I have 5 stories 

now. If I go back to that schedule, you can see there are some areas for this morph here that are 

progressively getting more or depending on the stories. So we could actually report on the morphs. 

[1:31:23] 

The only thing you can usefully report on is area or volume. So if you wanted to design a building that 

had some complex general shapes and see that it had the right amount of usable space at different 

stories, you could get some reporting there. So it's slicing through the morph at different heights and 

reporting the area of that in the story there. So you can see the base area here, we wouldn't want to 

show that; we would just have this. Now there must be an option to show the story. Where is it? I am 
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not sure why it's not showing the actual story number there. But we can do a total or a summation here. 

You can see here is the total area of that morph.  [1:32:42] 

Okay - so let's see if David R. writes. "It seems that the Morph tool does not have all the Boolean 

operations that is in Solid Element Operations tool. Is that true or can you do all the same things?" Yes it 

does, I just did not show that. "Can you use Solid Element Operations tool on morphs?" Yes you can. So 

the morphs, if I select any solid morph, let's put this through the wall here. Take this wall, solid element 

operations, and make it the target, make this morph the operator, do subtraction, execute. Now let's 

hide the layer this morph was on. So we will got the Layer and hide it by going to layers, hide layer. 

[1:33:45] 

Oh, this is on the ArchiCAD layer, so it can't be hidden. Let's put it on the demo layer. Go to 3D, and 

rotate around for you to see. There is that rather funny shape being cut out. That was a crude 

demonstration. In fact, that was part of what I demonstrated in the other lesson. The morph element 

was being subtracted from the wall. So if I go to this layer and hide it you can see that is what it did here. 

[1:34:22] 

So thank you all for your time and interest. The Morph tool is very rich and you will figure out more as 

you start to work with it. That's true of any tool, but the Morph tool in particular just has so much 

available. I didn't even cover all the commands here such as intersect, morph faces, and there are some 

other ones in there if you select morphs that you will get. Please feel free to send me some ideas, 

pictures, or examples of some things that you wonder if the morph tool can create. If there is enough 

interest, I will create another follow-up lesson. This has been Eric Bobrow; please add your comments 

and questions to the page down below, thanks for watching.  

[END OF AUDIO 1:35:20] 

 


